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This guide is distributed by EOSENSE INC (“Eosense”) for users of the eosAC autochamber instrument in 
conjunction with the eosLink and eosAnalyze-AC software. Eosense is not liable for special, indirect, 
incidental, or consequential damages. Eosense’s obligation under this warranty is limited to repairing or 
replacing (at Eosense’s discretion) defective products. The customer shall assume all costs of removing, 
reinstalling, and shipping defective products to Eosense where applicable. Eosense will return said 
products by surface carrier prepaid. This warranty is in lieu of all other warranties, expressed or implied. 



support@eosense.com
© Eosense Inc.

User Manual
User Manual

3

WARNING: CRUSH HAZARD

This symbol indicates that a crush hazard is present. Keep 
hands and all other objects clear of the bottom lip of the 
chamber and the chamber arms during operation. Never 
attempt to prevent the chamber from opening or closing. 

CAUTION: RISK OF DAMAGE TO EQUIPMENT 

This symbol indicates that there is a risk of damage to the 
equipment. Manually forcing an eosAC chamber to close can 
cause permanent damage to the internal electronics, even 
when unpowered and disconnected. If absolutely necessary, 
disconnect the eosAC completely then SLOWLY close the 
chamber using gentle pressure. Never attempt to manually 
close a powered chamber. 

This product complies with the following directives for CE Marking: 

2006/42/EC (Machinery)
2011/65/EU (RoHS2)
2004/108/EC (Electromagnetic compatibility) 

   
For more information, contact support@eosense.com 



support@eosense.com
© Eosense Inc.

User Manual
User Manual

4

Contents

1 Summary
1.1 eosAC User Manual

2 Introduction to Soil Flux Chambers
2.1 Soil Flux Chamber Measurements
2.2 Automated Chambers and External Analyzers
2.3 Measurement Overview

3 Quick Start Checklist

4 Hardware and Field Deployment
4.1  Connecting Picarro Gas Analyzers with eosAC/eosMX
4.2  Connecting LGR Gas Analyzers with eosAC/eosMX
4.3  Connecting eosAC autochambers to the eosMX
4.4  eosMX Power and Communication
4.1  Deploying eosACs in the field

5 Chamber Scheduling and Monitoring
4.1  Single eosAC
4.2  Multiplexed eosACs

6 eosAnalyze-AC
6.1  Setup
6.2  User Interface
6.3  Chamber/Analyzer Setup
6.4 Chamber Measurements

6.4.1 Importing Data
6.4.2 Data Table Fields
6.4.3 Filtering Data
6.4.4 Hiding Data Fields

6.5 Data Processing
6.6 Saving and Loading Data

5.6.1 Saving Data
5.6.2 Loading Data

6.7 Viewing Data
6.8 Exporting Data

7 TroubleShooting

5
5

6
6
6
7

8

9
9

11
12
13
14

15
15
15

18
18
19
20
22

   22
   23
   24
   25
26
27

   27
   27
28
29

30

This is an infobox
It provides extra information about 
your eosAC!

?
This is a warning
It tells you important details about 
how to keep you and your equipment 
safe!

!



support@eosense.com
© Eosense Inc.

User Manual
User Manual

5

1 Summary

1.1 eosAC User Manual

This manual is intended to help end-users of the Eosense eosAC autochamber setup and use their 
chamber system alongside of a multi-species gas analyzer to measure a variety of soil flux and gas 
concentration data. The information provided is intended for first time users of the eosAC, and assumes 
a working knowledge of the gas analyzer in question (the Picarro G2508 is used as an example 
throughout this document). We highly recommend that you read the document thoroughly before using 
the eosAC, as each of the hardware and software features are explained in detail.

This manual is intended for users of the eosAC with version 3.5.0 of the eosAnalyze-AC interface. 
Please check the Eosense website for the most up-to-date manuals and software.

If you have any specific questions or require additional guidance or information, please contact Eosense 
Technical Support through our website, by phone or by email:

support@eosense.com 
888.352.8313

http://eosense.com/support 

➔ Make sure your system is ready to go: Section 3 (Quick Start Checklist) lists everything you 
need to get your system up and running. Make sure to read the relevant sections of the manual 
for more information on each step!

➔ Want to jump right into collecting flux measurements? Section 5 (Chamber Scheduling and 
Monitoring) tells you all you need to know to start out. For best results, we do recommend you 
read the user manuals for both the eosAC and the eosMX multiplexer!

➔ Ready to start viewing and analyzing your flux data? Section 6 (eosAnalyze-AC) explains how 
the eosAnalyze-AC software allows you to import, view and quality check your measurements, 
before exporting the data.

➔ Running into problems? Section 7 (Troubleshooting) covers some of the most common issues 
and how to address them. And you can always contact us directly at support@eosense.com

http://www.eosense.com/
mailto:support@eosense.com
http://eosense.com/support
mailto:support@eosense.com
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2 Introduction to Soil Flux Chambers

2.1 Soil Flux Chamber Measurements

Ecological or anthropogenic processes can produce or consume a variety of gases in the soil 
subsurface, such as carbon dioxide (CO2), methane (CH4) and Nitrous Oxide (N2O). In the event of 
production, these gases are transported (typically diffusively) to the surface and emitted into the lower 
atmosphere, creating a positive flux. In the case of consumption, gases from the lower atmosphere can 
be absorbed into the soil, creating a negative flux. The most common method for measuring these 
emissions are soil flux chambers, which fall into a few categories.

The most common commercial flux chamber is the closed dynamic chamber, which when placed on the 
soil surface, accumulates gas in its headspace. The flux is then calculated based on the rate of increase 
in the chamber headspace concentration, which is the mostly widely used and studied method of 
estimating soil fluxes via chamber measurements.

For a detailed explanation and comparison of these different chamber designs, see Pumpenen et al, 
20111.

2.1 Automated Chambers and External Analyzers

The most common method of capturing the chamber concentration timeseries is through manual 
sampling, where methods such as syringe extraction are used to collect several samples of headspace 
gases for laboratory analysis at a later date. In order to automate the process and improve data quality, 
many researchers had switched to automated chamber systems coupled with dedicated gas analyzers. 
While the approach is essentially the same - fitting the chamber timeseries to estimate the rate of flux - 
the vastly improved temporal resolution and automation of the analyzer based system allows for more 
robust flux estimation. 

CO2 analyzers were among the first instruments to be used in this manner, and led to the development 
of various automated chamber systems. With the increasing sophistication and affordability of 
laser-based systems, measurement of other trace gas fluxes has become increasingly common. The 
eosAC and eosMX automated chamber system was designed for compatibility with leading gas 
analyzers, such as the Picarro G2508 and the LGR UGGA, allowing the analytical power of these 
instruments to be easily adapted into soil flux measurements.

1 Pumpanen, J et al. 2003. Comparison of different chamber techniques for measuring soil CO2 efflux. 
Agric. For. Meteorol. 3-4:159-76
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2.3 Measurement Overview

The following steps illustrate the specific sequences of events that occurs when the eosMX / eosAC 
system is collecting flux measurements in the field.

1. User connects all eosAC / eosMX / gas analyzer hardware

2. User runs eosLink-MX, which scans and detects any attached eosAC chambers

3. User creates or loads a measurement cycle and starts collecting flux measurements

4. The scheduled flux measurement begins
a. The eosMX sends a signal to the chamber to close
b. The eosMX switches valves so that gas from the chamber is flowing to the analyzer
c. The eosAC sends temperature, pressure and auxiliary data back to eosLink-MX
d. eosLink-MX stores all received data in an FRMonitor .log file

5. The scheduled flux measurement ends
a. The eosMX sends a signal to the chamber to open
b. The eosMX switches valves so that the analyzer is now drawing from the relief valve

6. Steps 4 and 5 repeat until the schedule has ended or the user stops it manually

7. User runs eosAnalyze-AC to begin importing flux measurements

8. eosAnalyze-AC combines analyzer data with the FRMonitor logs to create flux measurements

9. User reviews and adjusts data fitting as needed

10. User exports the flux measurement data for further analysis
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❏ Review Documentation
❏ User Manual for you specific analyzer
❏ eosAC / eosMX User Manuals
❏ Relevant Application Notes for your study (e.g. AN0010 - Powering the eosAC, eosMX 

and Gas Analyzer Using a Generator)

❏ Analyzer Setup (Picarro only)
❏ Send the contents of these folders to Eosense for modification

● C:/Picarro/G2000/AppConfigConfig/DataLogger/
● C:/Picarro/G2000/AppConfig/Config/Archiver/
● C:/Picarro/G2000/AppConfig/Config/PeriphIntrf/   (if present)

❏ Overwrite the previous folders with the returned files and restart the analyzer (using the 
Mode Switcher on the Picarro Desktop)

❏ Ensure that the UserData/DataLog_Forerunner directory structure was created
❏ Install the USB-Serial driver

❏ Eosense Software (Picarro)
❏ Download and extract the software folder for eosLink-MX and eosAnalyze-AC onto the 

analyzer desktop

❏ Eosense Software (LGR)
❏ Contact support@eosense.com for assistance installing the eosLink-MX software onto 

your analyzer
❏ Download and extract the software folder for eosAnalyze-AC onto the desktop of a 

windows PC

❏ eosAC/eosMX Hardware Setup
❏ Review the relevant Application Note (Picarro or LGR) for details on how to connect 

power, data and gas tubing in your system
❏ Connect the eosMX Multiplexer to power using the supplied power cable
❏ Connect gas tubing between the eosMX and your analyzer
❏ Connect the two USB cables from the eosMX to your analyzer
❏ Connect each eosAC to the eosMX using the combined power / data cable
❏ Connect gas tubing between each eosAC and the eosMX

3 Quick Start Checklist

http://www.eosense.com/wp-content/uploads/2016/05/Eosense-AN0010-Powering-the-eosAC-eosMX-and-Gas-Analyzer-Using-a-Generator.pdf
http://www.eosense.com/wp-content/uploads/2016/05/Eosense-AN0010-Powering-the-eosAC-eosMX-and-Gas-Analyzer-Using-a-Generator.pdf
http://www.ftdichip.com/Drivers/CDM/CDM21214_Setup.exe
mailto:support@eosense.com
http://www.eosense.com/wp-content/uploads/2016/03/AN0003-eosAC-eosMX-Picarro-analyzer-setup.pdf
http://www.eosense.com/wp-content/uploads/2016/03/AN0007-eosAC-eosMX-P-and-LGR-UGGA.pdf
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4 Hardware and Field Deployment

4.1 Connecting Picarro Gas Analyzers with eosAC/eosMX

The eosMX allows the user to coordinate Picarro gas analyzer samples from up to twelve eosAC au- 
tochambers (sequentially). The eosMX is constructed of light weight aluminum, and is designed to stack  
on top of a Picarro gas analyzer, with the external pump resting on top of the eoxMX. The three instru- 
ments should be connected in a continuous loop, as shown in Figure 1.

In order to create this loop, a number of components 
are required:

Picarro Analyzer (e.g. G2508)
Recirculation Pump (A0702)
Eosense eosMX Multiplexer
(A) Convoluted Metal Hose (VCR)
(B) VCR Coupling (SS-4-VCR-CG)
(C) VCR →Swagelok Fitting (SS-4-VCR-6-400)
(D) 1/4 Ferrule x2 (SS-403-1, SS-404-1)
(E) 1/4 Swage Nut x2 (SS-402-1)
(F) Vacuum VCR Connection
(G) VCR Metal Gasket x3 (SS-4-VCR-2)

Figure 1 Gas tubing connections between the analyzer, eosMX and external pump.

Figure 2 Gas tubing connections between 
the analyzer, eosMX and external pump.
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Carefully set the analyzer, eosMX and external pump on a 
flat surface and remove the caps from the
analyzer (Vacuum and Input) and pump (Vacuum and 
Exhaust), if still present. There are two ports on the back 
of the recirculating pump: one provides vacuum to the 
Picarro analyzer, which is necessary for its operation, 
while the other port acts as the gas exhaust for the 
system. To connect the external recirculating pump into 
the gas sampling loop, begin by attaching the VCR 
coupling (B) to the outlet port of the pump. Next, insert the 
VCR Metal Gasket (G) into the coupling and attach the 
VCR to Swagelok fitting (C). Once the VCR to Swagelok 
fitting (C) is finger tight, turn the fitting an additional 1/8th 
turn to compress the gasket. Next, attach the Vacuum 
VCR Connection (F) to the Vacuum port of the gas 
analyzer. Connect the pump and analyzer vacuum ports 
using the convoluted metal hose (A). Ensure that each 
connection receives a VCR Metal Gasket (G) and is 
tightened 1/8th of a turn past finger tight.

Before attaching the tubing between the analyzer and the 
eosMX unit, ensure that the unit’s main power is turned on 
so that the pressure relief valves are active. Depending on 
application, the tubing lengths for the eosMX setup may 
vary. If the eosMX will rest on top of the analyzer, then two 
lengths of tubing approximately 60 cm long are sufficient 
to connect the eosMX and analyzer. Pre-Swagelock fitted 
tubing lengths are included with your eosMX equipment. 
Using one of these pieces, attach one end to the gas 
analyzer inlet and the other end to the eosMX Inlet, hand 
tightening and then turning an extra 1/4 turn with a 
wrench. Using the other piece, repeat this process 
between the external pump Swagelock fitting (C) and the 
eosMX Outlet

Note: The Inlet port is required in order for the the gas 
analyzer to draw chamber samples, however the Outlet 
port need only be connected if you are interested in 
recirculating the sampled gas back to the chamber. 
Recirculation is recommended, as this minimizes the 
impact on the soil system and thus allows
for unbiased flux measurements.

Figure 3 External recirculating pump 
with VCR coupling and Swagelok fitting 
attached.

Figure 4 External recirculating pump 
with CVR coupling and Swagelok fitting 
attached.
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4.2 Connecting LGR Gas Analyzers with eosAC/eosMX

Up to twelve eosAC autochambers can be linked to the UGGA through the eosMX. Connecting the 
UGGA to the eosMX is accomplished through two pieces of tubing (Swagelock fitting on one end) and 
the two USB cables from the eosMX. With the UGGA off and using one piece of the provided tubing, 
connect the Swagelock end to the Inlet port on the back of the eosMX, and plug the bare end into the 
Inlet push-connect port of the UGGA, making sure it is firmly seated. Using the other piece of tubing, 
connect the Swagelock end to the Outlet port on the back of the eosMX, and plug the bare end into the 
Waste push-connect port of the UGGA, making sure it is firmly seated.

Note: The Inlet port is required in order for the the gas analyzer to draw chamber samples, however
the Waste port need only be connected if you are interested in recirculating the sampled gas back to 
the chamber. Recirculation is recommended, as this minimizes the impact on the soil system and thus 
allows for unbiased flux measurements.

Figure 5 Top: Inlet and Waste push-connect ports on the UGGA. Bottom: 
Inlet and Outlet ports on the eosMX.
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4.3 Connecting eosAC autochambers to the eosMX

The eosMX front face has connections for up to twelve Eosense eosAC autochambers, which include a
combined power / communication port and two Swagelok gas fittings for transporting gases to and from
the analyzer. Each connected eosAC will require a power/data cable and two lengths of tubing (Swage
fitting on one end only), with a maximum length of 15 m (LGR Analyzers) or 30 m (Picarro Analyzers).
Connect each chamber by attaching the bare end of one length of tubing to the Inlet port on the rear of
the eosAC by pushing the tubing into the quick connect port until held securely. Repeat this process with 
the other length of tubing and the eosAC’s Outlet port. Connect the Inlet tubing to an Inlet port on the 
front of the eosMX and the Outlet tubing to the paired Outlet port using the Swage fittings. Depending on 
the environment in which the analyzer and eosAC are deployed, steps to protect these lines from 
rodents and other wildlife may be recommended. Attach one end of the eosAC power/data cable to the 
back of the eosAC, ensuring that it is connected to the top left electrical port, labelled COMM. Connect 
the other end of the cable to one of the power/data ports on the front of the eosMX. Each eosAC should 
be connected to a power/communication port and the matching Inlet/Outlet fittings. For example, the first 
eosAC would connect to COMM 1, Inlet 1 and Outlet 1, while the next would connect to COMM 2, Inlet 2 
and Outlet 2 and so on. Each eosAC must be connected to matched gas and data ports. Connecting the 
power/data cable or tubing to the wrong ports will result in failed measurements and/or pressure issues 
with the connected gas analyzer.

Figure 6 Top: eosMX front face. Bottom: Diagram of the eosMX front face showing the 
correct pairing between power/data, inlet and outlet ports.
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4.4 eosMX Power and Communication

The eosMX power cable should be connected to stable 100-240 VAC power (43-67 Hz), and draws a 
absolute maximum of 430 W (under normal operation, peak draw is 108 W and the average is 20 W). 
The On/Off switch is located directly under the cable, with 1 indicating that the eosMX is powered, and 0 
indicating no power. The two USB cables should be connected to the computer that will be operating the 
chamber scheduling software and storing measurement logs (typically the gas analyzer itself).

13

Figure 7 Power/Data Cable connected to the eosAC

Figure 8 The rear face of the eosMX, showing gas analyzer Inlet and Outlet fittings; the eosMX 
power cable and On/Off switch; and the two USB communication cables.



support@eosense.com
© Eosense Inc.

User Manual
User Manual

4.5 Deploying eosACs in the field

Before deploying an eosAC, first clear any vegetation from the soil surface. The eosAC can be installed 
onto a previously installed soil collar (use a collar of at least 5 cm), or directly on the soil surface. Push 
the eosAC into the collar so that it is flush with the surface. Depending on the density of the soil, you 
may need to precut a circle for insertion. While the eosAC is water resistant, avoid situating the probe in 
areas of standing water or hollows where flooding is a possibility. For best results choose a flat, clear soil 
surface to deploy the chamber. 

When collecting eosACs from your field site, first close the chamber using the eosAC Control option in 
the eosLink-MX software. Once the chamber has fully closed, disconnect the power/data cable and 

tubing, then gently remove the chamber from its collar, disturbing the soil as little as possible. 

WARNING: Manually forcing an eosAC chamber to close can 
cause permanent damage to the internal electronics, even 

when unpowered and disconnected. Always use the eosLink-MX 
software to close the chamber whenever possible.

If absolutely necessary to close by hand, disconnect the eosAC 
completely, then SLOWLY close the chamber using 

gentle pressure.

Never attempt to manually close a powered chamber. 

14

! !

Figure 9 An eosAC deployed in the field using a simple PVC collar.
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5 Chamber Scheduling and Monitoring

5.1 Single eosAC

Please see Application Note AN0006 (available through support@eosense.com) for information on how 
to connect a single eosAC directly to a Picarro gas analyzer. 

5.2 Multiplexed eosACs

The eosLink-MX software is used to collect and store peripheral data from and control the measurement 
cycle of up to twelve eosACs. eosLink-MX logs temperature, pressure and peripheral data from 
connected eosACs while also serving as the control panel for the eosMX Multiplexer. 
The main window shows the current connection status 
(Idle, Searching, or Measuring), the type of 
Measurement Cycle (Default or Custom), the current 
and next steps in the current cycle, and the detected 
eosAC. Once a Measurement Cycle has been selected, 
clicking the Start button will begin the cycle, with a new 
option to Stop measuring at any point. 

As each step in the cycle completes, the main window 
will be updated to show the new current step (with time 
remaining) and the next step in the cycle (with duration). 
The numbers underneath the “Multiplexer” heading will 
also update, with unused multiplexer ports grayed out, 
and currently closed chambers in bold. If the cycle is set 
to loop (see Figure 13), it will continue until manually 
stopped, otherwise the program will return to an idle 
status when the cycle is complete. 

A number of chamber specific notifications can be 
viewed by clicking on the System Info button. This 
window contains a tab for each of the twelve possible 
eosACs, showing the most recently collected 
temperature and pressure data, as well as the current 
status of the chamber and any related warnings or

Figure 10 The eosLink-MX main window, 
showing an active cycle with two detected 
eosACs

messages. If eosACs are experiencing issues, this is the first place to look for diagnostic and 
troubleshooting purposes. The Refresh Data button will update the displayed chamber data, while the 
Chamber Timing button opens the Adjust Chamber Timing window. This screen shows the current 
chamber’s ID number and on-board compression time, which controls the seal of the chamber against 
the lower gasket. In the event that a chamber is not seating properly when closed (either not closing 
tightly enough or “popping”), the compression time can be adjusted from this window to resolve the 
issue, with the Open and Close Chamber buttons allowing you to quickly test different compression 
settings.
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Figure 11 The System Information window, showing chamber notifications and recent data collected. 

Figure 12 The Adjust Chamber Timing window, showing an eosAC 
using a compression time of 800 ms.
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steps, as well as save or load custom cycles. As the 
number of measurements is increased, steps will be 
added to the scrolling window, to a maximum of 50. 
These steps can be set to either Idle or a Chamber 
measurement by clicking on them, then setting the 
measurement type and duration.

Checking Loop Cycle will cause the specified 
measurement cycle to begin from the first step each 
time the cycle completes. Checking the Use 
Default box will reset the measurement cycle to a 
simple loop through each detected eosAC. 

The Valve Delay options specifies the amount of 
time to wait between starting to draw gas from the 
chamber and the chamber closing (“Pre”) and the 
length of time to wait between the chamber opening 
and the end of gas being drawn from this chamber 
(“Post”). The optimal setting for these delays varies 
depending on a number of factors - increasing with 
tubing length and other factors that increase the 
total system volume, and decreasing with increased 
flow rate. Generally, we recommend setting these 
Pre and Post values to at least 45 and 90 seconds 
respectively, but strongly recommend you 
review these settings after collecting 
representative field measurements, in order to 
prevent data issues.

Figure 13 The Create Measurement Cycle 
Window, showing a custom chamber cycle

From the main eosLink-MX window, the measurement cycle can be configured by clicking the Change 
button. This brings up a window that allows the user to choose the number and type of measurement 

Valve Delays and Good Data
Setting sufficiently long Valve Delays is 
crucial to collecting accurate flux data. 
Application Note 011 (“eosMX Valve 
Delay and Setting Data Deadbands”) 
provides additional details concerning how 
these parameters affect flux estimation.

?
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6 eosAnalyze-AC

6.1 Setup

The eosAnalyze-AC software requires no installation on the part of the user. Simply copy the 
“eosAnalyze- AC.zip” file to a suitable directory on the PC in question, then unzip the file (which contains 
one folder titled “eosAnalyze-AC”). None of the files in this folder should be removed or changed in any 
way. If this occurs, simply delete the entire folder from your PC and re-extract from the zip file to recreate 
the folder.

The program executable is labeled “eosAnalyze-AC.exe”, and creating a shortcut to this file program on 
the Desktop is recommended. Double clicking this icon or a Desktop Shortcut will launch the software. 
Please note that the data collected by the companion programs eosMonitor-AC (no eosMX) or 
eosLink-MX (multiplexed chambers) is required in order to import accurate temperature measurements, 
and in the case of a multiplexed system, open and close the chambers. Section 4 provides more 
information on how to monitor and customize these programs.

The first time eosAnalyze-AC is run, both the Analyzer and Chamber types need to be selected, and the 
user will be prompted to chose both sequentially. The Chamber Type indicates whether a single eosAC 
is connected directly to the gas analyzer, or if multiple chambers are connected via a eosMX unit. The 
Analyzer Type indicates which gas analyzer the user will be collecting data from.

These choices will be saved and loaded on each subsequent use of the eosAnalyze-AC. If required, they 
can be changed from the Options⇒Equipment menu. Please note that incorrect measurement data or 
processing issues may occur if these options are set incorrectly. The currently selected Analyzer and 
Chamber will be displayed in the software’s title bar (see Figure 15). 

Figure 14 The windows for selecting the Analyzer and Chamber types. 
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6.2 User Interface

Once the program is running, the main viewing window will appear. This window consists of two main 
areas: the Plotting section and the Measurements section. Both sections will be empty until data has 
been imported. 

The Plotting section on the left of the main window allows the user to quickly inspect up to three different 
time-series plots at a time from the chamber measurements collected. The Display Data For drop-down 
menu allows measurements from one or all detected chambers to be displayed. Each of the three plots 
can be changed using the drop-down menus in the upper left of their areas, and the Y-axis behavior can 
be toggled between Automatic and Fixed scaling. The X-axis type and scaling for all three plots can be 
changed using the buttons at the bottom of the plotting area.

The two buttons underneath of the Measurements window allow the user to collect and then export 
chamber data. Chamber measurements detected by the program will populate a list in the 
Measurements area to the right of the main window. This scrolled window allows the user to view a 
customized table of data from the analyzer and chamber, as well as modify individual measurement 
parameters such as the deadband range or chamber offset.

In addition to these two main sections, a number of options are available from the menu toolbar at the 
very top of the screen (File, Data, Options, Help). 

Figure 15 The main eosAnalyze-AC window, showing imported chamber measurements. 
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6.3 Chamber/Analyzer Setup

The first parameter that must be set is the analyzer data path, which corresponds to the location of 
stored analyzer data files on the computer. The analyzer path can be changed by selecting Analyzer 
Data Path from the Data menu at the top of the screen. This will prompt the user to specify a data path 
using a popup window: 

Please note that the correct folder is selected by navigating to the root level of the data folder. In the 
case of Picarro analyzers, this is the folder containing annual folders such as “2015”. Once you have 
navigated to the correct location, click OK to set the path.

The Chamber and Analyzer Settings window can be found under the Options⇒Equipment menu at 
the top of the screen, and allows the user to modify a number of chamber and analyzer specific settings. 
The majority of these settings are related to the total volume occupied by the chamber, the analyzer 
cavity and the tubing connecting the two. These values are chamber specific: if using a single eosAC 
without a Multiplexer, then Chamber 1 is the correct setting. For multiple chambers, the chamber 
selection corresponds to which Multiplexer port a given eosAC is connected to). These settings can be 
changed after data has been imported, however this will require reprocessing of all of the flux data, so 
configuring these values before collecting data is recommended.

The tubing volume is expressed via the length (m) and inner diameter (mm) for convenience. The 
chamber and analyzer volumes would remain unchanged under normal operation, as the Auxiliary 
Volume and Chamber Surface Area options allows the user to include any aftermarket modifications 
they may have made to the system (with the latter corresponding to the total surface area exposed to the 
soil). The final volume related setting is Chamber Offset. This value represents the distance between 
the top of the soil collar and the soil surface, with the minimum value being 2.57 cm. This offset is then 
transformed into an additional volume by assuming that the soil surface area within the collar is equal to 
the chamber’s surface area.

The Error Reps setting dictates how many fitting iterations will be used to estimate the parameter error 
for the linear and exponential flux/Keeling intercept values. For demonstration purposes, this value 
defaults to 3. 

Figure 16 The data path selection window, showing the expected annual data folders. 
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Note that changing this value can dramatically increase processing time, depending on the amount of 
data collected. A more in-depth explanation of this error estimation is available upon request. Finally, a 
global temperature and pressure can be applied to all chamber measurements using the Set Chamber 
Pressure and Set Chamber Temperature options. These temperature and pressure values will 
override those reported by the eosAC chambers, and should only be applied in the event of chamber 
data loss or malfunction.

The Apply To drop-down menu at the bottom of the window specifies which set of chamber 
measurements to modify. Please note however that any changes to the number of error reps or the 
analyzer volume will affect all chamber measurements. 

Figure 17 The Chamber/Analyzer settings window, where a number of equipment settings can 
be modified. 
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6.4 Chamber Measurements

6.4.1 Importing Data

Analyzer data can be imported by clicking the Collect Data button below the Measurements window. 
This will prompt the user to select a time and date range in which to search for chamber measurements. 

This data interval does not need to be exact, however only 
chamber measurements falling within this range will be 
processed. The Analyzer Local Time option at the bottom 
is used to correct for any GMT offsets that may exist: this 
value should be set to correspond with the analyzer’s local 
clock at the time the chamber data was measured. 

Once the data interval has been set by clicking OK, the 
program will begin searching through the analyzer data 
files to find chamber measurements. During this process 
many GUI elements will be disabled as the Measurement 
and Plotting sections are updated. Progress bars 
indicating the status of the data search and measurement 
processing can be found in the area directly below the 
Collect Data and Export Data Table buttons: 

As new measurements are found, they will be used to 
populate the Measurement and Plotting sections of the 
main window. Once the entire data interval has been 
searched and all fitting is complete, normal GUI 
interaction will be restored. Additional measurements can 
be added to the same data table by clicking the Collect 
Data button again, and by specifying a new data interval. 
Any measurements that have already been added to the 
Data Table will be ignored on subsequent searches. Figure 18 The data interval selection window

Figure 19 The eosAnalyze-AC main window progress bars, indicating that the imported 
measurements are currently being processed. 
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6.4.2 Data Table Fields

Once analyzer data has been parsed for the eosAC measurements, a number of data fields will be 
displayed in the Data Table. These default parameters are analyzer specific, but generally include gas 
flux, gas concentration and analyzer diagnostics information. Mousing over any of the table values will 
indicate what field it corresponds to as well as the units. 

Fields that are not currently displayed can be added by clicking on the Data Table header (or from 
Data⇒Customize Data Table), and customizing the table using the pop-up window. From this window 
the number of columns can be adjusted, as well as what parameter will be displayed in each column. In 
addition, the timestamp that is used for each line of the Data Table can be changed to one of three 
options: 

● Julian Day - Fractional days elapsed since January 1 of respective year
● Date/Time - Timestamp using MM/DD/YYYY HH:MM: format
● Hours Elapsed - Hours elapsed since start of first measurement

Please note that the number/order of columns and the chosen timestamp will be reflected in any 
exported data. You may need to scroll the Data Table in order to view all columns.

Figure 20 The eosAnalyze-AC main window data table, with several chamber measurements 
shown.

Chamber Errors
Chamber errors logged by the eosLink-MX software will be read by the eosAnalyze-AC 
software and indicated both by marking the Data Table entry in red for the associated 
measurements, and by flagging the exported data. This includes incidents where a chamber 
may be unable to open or close fully.

?
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6.4.3 Filtering Data

Chamber data can be filtered in order to automatically disable any measurements which qualify as 
outliers. The outlier range is a field-specific setting, accessed from Outlier Filters in the Data menu.

The Data Field drop-down menu selects which measurement value to set the filter for, with all ranges 
defaulting to No Filter. Selecting a filter will cause measurements outside the allowable range to be 
disabled (grayed out), meaning that they will not appear in the main window’s plots or any exported data 
files. Please note that this feature is not intended as a replacement for robust statistical post-processing, 
but as a means to quickly remove outliers. 

The flux estimates for each chamber 
measurement will default to a unit generally 
appropriate for the gas in question (μmol/m2/s 
for CO2 and NH3, nmol/m/2/s for CH4 and 
N2O). These can be changed from the Data 
menu under Flux Units, either prior to or after 
data collection. This window allows the flux 
units to specified arbitrarily from various mass, 
area and measurement time settings, such as 
kg/km2/year or nmol/ha/hour. 

Note that some combinations of units may be 
rejected if they would typically produce 
extremely large (e.g. nmol/km2/yr for CO2 flux) 
or extremely small values (e.g. kg/m2/s for CH4 
flux).

Figure 21 The Customized Data Table Window 

Figure 22 The window used to change the flux units displayed
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Finally, clicking Reset All Filters will select No Filter for each data field. Please note that this will enable 
all chamber measurements, including those manually disabled by the user through the Measurement 
Settings window. 

6.4.4 Hiding Data Files

In the event that any of the default data fields are unlikely to be useful for your application, they can be 
hidden (“ignored”) from all eosAnalyze-AC options. To ignore a data field, select Ignored Data Fields 
from the Data menu, choose a field from the drop- down menu and then click Add. To remove an 
ignored field, simply click the corresponding name in the scrolling list to the right. 

Ignored data fields will not show up as options in the plot selection or data table customization menus 
until they are removed from this list. 

 

Choosing Standard Deviation allows the user to 
choose the distance from the mean value a 
measurement can be before it is considered an 
outlier. The user can choose between 1 or 2 for the 
allowable range, with the corresponding minimum 
and maximum values shown in parentheses. For 
normally distributed data, this represents inclusion 
ranges of 68 and 95% of the total range, respectively. 
By choosing Custom Range, the inclusion range can 
be set arbitrarily, within the limits of the value’s global 
minimum and maximum. This can be used to select 
only certain portions of the dataset, or to avoid 
problematic measurements (e.g.: high Water Content 
or ChemDetect). 

Figure 23 The Customized Data Table Window 

Figure 24 The window used to change which data fields are ignored by the data processing software
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6.5 Data Processing 

Individual measurements can be viewed in greater detail by clicking on them in either the Data Table or 
one of the main plots, which brings up the Measurement Settings window: 

The flux fits and Keeling plot intercepts (isotopic analyzers only) for any relevant gases can be viewed 
using the drop down menus in the top right of the window. Directly below these buttons are the specific 
parameter estimates for the shown fit, followed by the current deadband settings. Data from the 
beginning or end of the timeseries can be omitted by changing these settings using the Data Domain 
spin buttons. Note that changing these options will result in a brief updating period while the fits are 
recalculated, once the Measurement Settings window is closed.

The chamber temperature, chamber pressure and chamber offset (distance between bottom of chamber 
and soil due to collar) can be modified from their default values as well. Note that chamber temperatures 
and pressures will be read in from a separate log file if available (see Appendix A). The Use 
Measurement check box can be unchecked to exclude the displayed measurement from both the 
(exported) data table and the main window plots. The Apply Deadband Range To All check box can be 
checked to apply the deadband setting to all current data table measurements. Please note that no other 
measurement settings will be affected by this option.

The user can enter a metadata string directly below the Measurement Settings plot. This string can be 
up to 200 characters long, and is used to make any notes about the measurement/environment or other 
important details. Holding shift while clicking the plot provides an option to export the current data as a 
PNG or JPEG image. 

Figure 25 The Measurement Settings window, used to view and alter the fits to chamber timeseries. 
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6.6 Saving and Loading Data

6.6.1 Saving Data

To save a eosAnalyze-AC session, select Save from the File menu, then choose a filename and path. 
This creates a .cds settings file and archives all analyzer data for the collected chamber measurements. 
In the event that this file is transferred to a different PC, the settings file can be used to reload the Data 
Table and chamber/analyzer/measurement settings, however the data can not be re-processed without 
also transferring the archived folder of analyzer data.

6.6.2 Loading Data 

To load a eosAnalyze-AC session, select Load from the File menu, then browse to a .cds save file. 
Clicking Open will repopulate the Data Table as well as load all previously selected plotting, 
measurement, chamber and analyzer settings. As long as the settings file is loaded on the same PC that 
created it, measurements can be reprocessed and modified exactly as if they had been newly imported. 

Figure 26 The eosAnalyze-AC Save window, used to select a filename and location. 

Figure 27 The eosAnalyze-AC Load window, used to select a CDS file to open. 
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6.7 Viewing Data

Along with the Data Table, chamber data can be 
viewed via three plots on the left of the main 
window. Each plot can be customized using the 
drop down data selector, the Y-axis settings and 
the X-axis settings, and all three can be hidden 
using the Hide Plots checkbox. In addition, the 
style of all three plots can be modified from the 
Plotting Options window, found under the 
Options menu. Note that if both Lines and Symbols 
are turned off, nothing will be shown in the plots. 

The Y-axis is automatically scaled by default. As 
long as this option is left unchanged, the (unused) 
Fixed Y-axis settings will be updated to reflect the 
current plot zoom. Once Fixed Y-axis is selected for 
the first time, this relationship will be broken, in 
order to prevent loss of user-specified axis settings.

The X-axis type can be selected at the bottom of 
the Plotting section, and can be set to Julian Day 
(since January 1 of that year), Hours Elapsed 
(since start time) and Measurements (sequential 
numbering). Unlike the Y-axis settings, switching 
back to Automatic X-axis scaling will always result 
in the Fixed X-axis settings being changed along 
with the plot, to allow for the inclusion of new data. 

Mousing over a plot will display the X/Y coordinates 
at that location and holding shift while clicking will 
save the current plot as an image 

Figure 28 The eosAnalyze-AC main window 
showing three plots. 

Figure 29 The Plotting Options window
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6.8 Exporting Data

Once all the chamber data has been collected and 
fine- tuned, the user can export the Data table as 
either a .csv or .dat file using the Export Data Table 
button at the bottom left of the screen. This prompts 
the user for a for- matting type, followed by a pop-up 
window to choose the save location. Note that data 
fields present in the table will be present in this 
exported file, and that measurements that have been 
deselected (appearing grayed out) will be excluded. 
This data can then either be used directly, or easily 
imported into a spreadsheet for further analysis. 

Figure 30 The window showing selection of 
the output file type. 

Figure 31 A sample of exported chamber data, viewed as a spreadsheet. 
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7 Troubleshooting

This section provides a few example problems that may occur during use, and the appropriate action 
that should be taken to resolve the issue. For these issues as well as any others that arise, please 
contact Eosense through email at support@eosense.com with subject “eosAC Support”, or through the 
support section of our website (http://www.eosense.com/support/). 

● eosAnalyze-AC does not find any data
Ensure that the analyzer root path has been set correctly by choosing Analyzer Data Path from 
the Data menu and navigating the the proper directory. One or more folders indicating year (e.g. 
“2014”, “2015”) should be visible when clicking OK from the pop-up window. Ensure that all 
relevant FRMonitor ####.log files are present. Double check the time-frame in which the 
measurements occurred and/or try expanding the data interval. Ensure that the Analyzer Local 
Time option has been set to correspond with the analyzer clock setting at the time the data was 
recorded. Finally, note that very short chamber measurements (typically <45 s) will be dropped. 

● The window failed to render properly/plots are not displaying, how can I fix this?
Clicking on an empty part of the screen will refresh the display. If this does not resolve the 
problem, try changing the X-axis plotting type (Measurements, Timestamp, etc). You should also 
check that at least one of Show Lines or Show Symbols is checked in the Plotting Options 
window. If the problem remains, restart the eosAnalyze-AC software. 

● The program takes a long time processing chamber measurements, is there any way to 
speed this up?
The majority of processing time occurs when the data is being fit to linear and exponential forms. 
If the chamber concentration data is particularly unusual, this can increase the fitting time 
significantly. Once the measurements have been imported, inspect measurements visually (via 
the Measurement Settings window) to ensure that the data is correct. In addition, the estimation 
of flux fitting errors/sensitivities can be very time consuming. If you have increased the error reps 
value beyond the default 3 (Chamber/Analyzer Settings window), try reducing this value to 
decrease processing time. If you have turned on symbol plotting from the Visual Options window, 
disabling this feature can increase plotting speed, and plots can be temporarily hidden entirely 
from the Hide Plots checkbox. 

● Running the software gives an error:”libgdk-win32-2.0-0.dll is missing from the computer” 
This error indicates that the executable is missing the (hidden) system files. This happens when 
the .exe is moved from its original position in the software folder. To resolve this problem, keep 
the executable in the same folder as it was downloaded in (or re-extract the .zip file and use that 
as the new software folder). 



User Manual
User Manual

31

Eosense Inc
1 Research Drive
Dartmouth, Nova Scotia
Canada, B2Y 4M9
Email: support@eosense.com 
http://eosense.com/support 
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